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Customizing CLM Templates

Instructional Guide

Presenter
Presentation Notes
OSD welcomes you to this CLM Instructional Training about Customizing CLM Templates.  Consider this an Instructional Guide for Executive Branch buyers who have Document Manager permission in the Contract Lifecycle Management area of COMMBUYS CLM.
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Objectives
Today You will Learn
• What templates are and how they work in CLM

• How to customize templates to fit Department 
needs 

• How to map Word bookmarks to CLM fields

• How to deploy a newly customized template so 
that it replaces the global version

Presenter
Presentation Notes
This guide

Describes what templates are generally and how they work in CLM specifically;
Shows steps departments can take to customize global CLM templates to fit department needs;
Explains how to map something called “Bookmarks” in Microsoft Word to CLM fields.  
And finally, how to replace the current template with the updated one so that any new CLM records employing the template will be using the customized version.
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What Are Templates?

Template: A preset 
format for a 
document or file, 
used so that the 
format does not 
have to be recreated 
each time it is used

Presenter
Presentation Notes
We encounter templates frequently in our lives. 
  A preset format for a document or file, used so that the format does not have to be recreated each time it is used. Forms are templates, where blocks are left blank for users to fill in with relevant data. 

  Templates are time saving and consistent.  For instance, every w-9 form for a particular calendar year looks the same.
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CLM Templates

The Working Document at each CLM 
phase is a Template. 

Data entered into CLM fields injects into 
the Template to create a procurement 
document. 

Usually, further editing is necessary 
before a document is ready for 
distribution.

Presenter
Presentation Notes
At each Phase in CLM… Strategy, Bid Package (announcement), Bid Package (RFR or Due Diligence), and Contract, a template is presented as the Working Document.   
Data entered in CLM fields inject into templates to create procurement documents, contracts, and other associated documents.  In this case, the depicted Template is for a Request for Response.  Usually, further editing is necessary before the document is ready for distribution, but even using the globally provided version saves time and is consistent for each instance. 
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Available Pre-Award Templates

CLM Record Type Associated Template
(Working Document)

STRTGY Sourcing Strategy Template
BIDPKG RFI (Request for Information)
BIDPKG Due Diligence
BIDPKG Intent to Procure
BIDPKG Request for Response

Presenter
Presentation Notes
The table here shows the templates that occur as Working Documents during pre-award stages in COMMBUYS CLM today.
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Who can customize templates?
It would be cool to 

change a template to 
fit my department’s 
needs, reduce editing 
time, and be more 

efficient!

COMMBUYS Basic 
Purchaser
CLM Access
Document Manager
Advanced Microsoft 
Word user 

Presenter
Presentation Notes
But wouldn’t it be cool to be able to alter a template to fit department needs, reduce editing time, and just be all around more efficient?  Yes, it would.  

   COMMBUYS users with CLM access who are assigned Document Manager Permission can customize templates, starting with the RFR Template for now with more being developed and released for department customization in the future. 

The COMMBUYS Organization Administrator for your department assigns these roles and permissions.  

Advanced Microsoft Word knowledge will be really useful to Document Managers. 
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Step 1: Call the OSD Help Desk

OSD Help Desk
1-888-627-8283 

or 
617-720-3197
8am - 5pm ET 

Monday – Friday 

Template for all Template for your 
department

Presenter
Presentation Notes
Before you can begin changing things, the OSD Help Desk must create a copy of the Global Template assigned to your department only.     That way, changes you make to the template assigned to your agency stay with your agency.  

Help Desk staff are available Monday through Friday from 8:00 am to 5:00 pm.  
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TIPS: Two Programs
Template editing occurs in 

Microsoft Word Amended template is uploaded into CLM

Presenter
Presentation Notes
Ok.  Before we dive into the editing process, let’s review some tips that will help you keep your bearings.  

First of all, template editing happens in Microsoft Word.  The currently available templates are Word documents, so changes are made and saved in MSWord. Then the amended document is uploaded into CLM.   You may toggle between Microsoft Word and CLM several times before the new template is just as you want it to be for your department.
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TIPS: Bookmarks and Fields
Templates include placeholders. 
Word calls these “Bookmarks” CLM has fields.

• CLM has Fields. 
• Fields have labels.
• During Bid Package 

creation, data entered 
into fields inject into 
the bookmarked 
places in the Working 
Document (template).

Presenter
Presentation Notes
The templates include placeholders that Word calls bookmarks.  Bookmarks that link up to Fields in CLM must be named with the prefix “fld_” and may include no spaces, special characters, or numerals at the end. The highlighted areas here are bookmarks.  Word bookmarks have other functions, too, like section headings, but for our purpose today, we are focusing on those bookmarks that link up to CLM Fields. 

During Bid Package creation, data entered into fields injects into to bookmarked places in the Working Document. 
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Single Sign On to CLM

Presenter
Presentation Notes
Now that we’ve established some background, let’s login to COMMBUYS CLM.  Remember to use Single Sign On!  Then go to the CLM Home page by selecting CLM Home from the Settings menu in COMMBUYS.
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CLM Home Page – Select Search

Presenter
Presentation Notes
Next, we must find the RFR Template that the Help Desk has created for the Department. From the CLM Home Page, click on Search.  Search criteria displays in a small font.  Click on Advanced.
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Advanced Search Selection
1. Under Search In

select Form and 
Document from 
the drop-down 
menu.

2. Under Field select 
Form Number.

3. Set the Condition
to is.

4. When the form 
number is 
unknown, type the 
Wildcard (%) into 
the Value field

5. Click the Search 
button.

Presenter
Presentation Notes
The Advanced Search Selection box appears.  This tool allows users to define what they are looking for.  In our example, we will display all of the “documents” available to the user.  

First, under Search In, select Form and Document from the drop-down menus.
Under Field select Form Number.
Set the Condition to is.
When the form number is unknown, type the Wildcard character into the Value field.  CLM recognizes the percent symbol as the wildcard.

Then click Search.



Search Results

1. Find the RFR document assigned to 
your agency.

2. Click the Form Number hyperlink.

Presenter
Presentation Notes
The Search Results show a list of all documents created in CLM.  Listed in the far right column is the Status of each document. In our example, all of the listed documents are Deployed templates.  Some of the listed templates are not complete.  OSD will continue to roll out templates as they are ready. 

Document descriptions follow a naming convention that includes the type of record it’s associated with, followed by a dash or hyphen, followed by a number..underscore…and a description of what the document is. The number represents your Agency.  Many of these documents are “global”, available for all agencies to use but not to Amend. Some are issued to other agencies.  While you may be able to open and look at these, only the Document Manager for the assigned agency can Amend a template.  And, at this stage, only the RFR is available for departments to amend.

Look for the RFR document that includes the Agency Code for your department.  These are the same as in COMMBUYS.  OSD’s number is 1080 so almost all documents displayed here are assigned to OSD. 
 
Notice there are 3 RFR documents in the black box, each assigned to a different agency.  Once the Help Desk has copied the RFR template and assigned it to your agency, it will appear on this list.  
 
In this example, we are selecting the Document Hyperlink for the RFR Template assigned to Agency Code 1021.



Document window

14

Presenter
Presentation Notes
The document window opens.    Note the status in the gray ribbon at the top of the page is labeled “Deployed”.  
Click the Amend button at the bottom of the page. 
The document redisplays, this time showing the status "amending”.   
Next, click the Hyperlink for the attached document, which will download to the destination your computer has designated for downloads. 



Amending in Word:  Displaying Bookmarks
The template already includes many Bookmarks 

that are mapped to fields in CLM. 
Make Bookmarks Visible:

1. Click Enable Editing at the top of the page.
2. Click the File menu, select Options, then select 

Advanced.  
3. Scroll down to the section Show document content
4. Check the box to Show Bookmarks
5. Click OK at the bottom of the page.

Be sure 
to click 
“Enable 
Editing”

Presenter
Presentation Notes
Find the file location where the document downloaded and open it.   
  Click “Enable Editing” at the top of the page upon first opening.  

The template already includes many Bookmarks that map to fields in CLM.   One recommendation is to make sure your word settings are set to Show Bookmarks.  
Click the File menu,   select Options, then select Advanced.  
Scroll down to the section Show document content
Check the box to Show Bookmarks
Click OK at the bottom of the page.
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Begin Editing the Document

Changes to your Departmental 
RFR Template may be simple or 
complex.  This guide will 
demonstrate how to :
1. replace the logo;
2. add text that will always be 

in the new template;
3. add a placeholder bookmark 

where you would like data 
entered in CLM to inject into 
the document;

4. map Word Bookmarks to 
CLM fields.

Presenter
Presentation Notes
The first page of the RFR template includes instructions.  Remember, this template was created to be universal--all Executive Agencies can use it.  

Items highlighted in red throughout the document must stay in your customized RFR.
Are there optional items that never apply to your department?  The Document Manager may edit the template to exclude those items. 

Your edit may be simple or more complex.  Here we will demonstrate a few things you can do such as changing the Logo, adding text, removing text, and adding a bookmark as a placeholder where you want information from CLM to inject into RFR documents your agency issues. AND, how to map those new Bookmarks to CLM fields. 
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Add a Custom Logo

To substitute the official 
Commonwealth seal with one 
for your agency:
1. Right click on the logo
2. Select Change Picture from 

the menu
3. Select the location of the 

logo file from the menu. 

Click SAVE in Word to save that 
change. 

Presenter
Presentation Notes
The baseline RFR template includes the state seal.  If your department or agency has an official seal of its own, your template can display that instead. 

There are several ways to change the logo. Here’s one:   Right click on the logo, CLOCK then select Change Picture from the menu. Finally, select the location of the logo file you want to use from the menu. 

Click SAVE in Word to save that change. You may change the file name if you would like to, though changing it is not necessary.
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Add or 
remove 

text

Presenter
Presentation Notes
Displayed here is the first content page of the baseline template.  Number 1 is unedited.  
For number 2, we’ve eliminated the Red Highlights from section 1.1 and added text that will always be included in this department’s Procurement Scope and Description.   Our example department only procures under MGL chapter 7 section 22, so we’ve eliminated the other options and removed the highlighting from section 1.3.  Similarly, our example department never partners with other departments to procure.  Section  1.6 now includes only the issuing entity.

As always, Click SAVE in Word to lock in those changes. 
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What bookmarks are already in the template?

1. Click the Insert tab on the Word Ribbon.
2. Click the Bookmarks icon.
3. Scroll to see all the bookmarks included in the template. 
4. Highlight a Bookmark Name and click the GoTo Button to see 

where the bookmark leads.  

NOTE:   Only those bookmark beginning with fld_ are placeholders/injection points for data from CLM. 
Other bookmarks may be labels for Section Titles or other information. 

Presenter
Presentation Notes
Ok.  Before we go on, we’ll learn a bit more about Word Documents.  What bookmarks are already in the template? To find out, click the Insert tab   on the Word Ribbon.
Then, click the Bookmarks icon.  
Scroll to see all the bookmarks included in the template. 
Highlight a Bookmark Name and click the GoTo Button to see where the bookmark leads. 

Note: Only those bookmark beginning with fld_ are placeholders/injection points for data from CLM. Other bookmarks may be labels for Section Titles or markers for other information. 
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Adding Bookmarks… Easy as 1…2…3!
Scenario
A department wants the Procurement Title to appear in the 
Description area as well  as on the Title Page. 

NOTES:   
• A bookmark may only point to 1 location in the document.  

• Bookmark name that link to CLM fields must begin with fld_
• Bookmark names may not contain spaces, special characters, or 

numerals at the end.

Go to the spot in 
your document 

where you want to 
place a bookmark.

Type the name of 
the new bookmark, 
then highlight the 

text.  Click CNTRL+C

Access the bookmarks 
(insert>bookmarks).
Paste the text into the 
name box. Click Add.

Presenter
Presentation Notes
Here’s a What If Scenario for you.  A department wants the Procurement Title entered into CLM during Bid Package creation to appear in the Description section as well as on the Title page.    As it turns out, a bookmark can only point to one area in your document.  Kind of like in real life;  your bookmark goes to just one page.  To mark other pages, you need other bookmarks.

Adding bookmarks is easy.    Go to the point in the text where you want to place a bookmark.  Type the name you want to give the bookmark.  Be sure to follow the rules!  The name must start with fld_ and cannot contain spaces or numerals at the end.  In the example, we’ve typed fld_solicitationTitleTwo, that’s t-w-o. Now highlight the text you just typed. Click CNTRL+C to copy the text.

For The last step, access the bookmarks like we just did.  Click Insert  on the ribbon, then bookmarks button. Now click into the bookmark name  box and paste the text in. Lastly, click the Add button. Now let’s see how that looked in the document.
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How does that look in the document?
Text for 

new 
Bookmark 
typed and 
highlighted
. CNTRL+C 

to copy.

Brackets 
show that 
the text is 

now a 
Bookmark.

Bookmark name pasted 
into the name box. 

Click Add.

Presenter
Presentation Notes
First, we found the spot where we want the placeholder to go.  We typed the new Bookmark Name, then Highlighted the text, and copied it. 
Next we went to the Bookmarks box, pasted the text into the name box, and clicked ADD.

In the text, the bookmark is placed.  We can see this because the text is bracketed, which is how bookmarks look. 

Be sure to save the document again!  Once editing is done, we will upload this new version into CLM.  Remember, we left the document “container” page in Amending status. 
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Uploading the Template to CLM

Presenter
Presentation Notes
Let’s go back to CLM to upload this customized template.  Certainly, during all this editing, COMMBUYS CLM has logged you out, so log back in using SSO, Go to the CLM Home Page and select Advanced Search,  select the same options as before. From the search results, Select the RFR template assigned to your department. It will be in amending status. 
Click the Document link. 
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Uploading the Newly 
Edited Template

In the field labeled Upload 
Document is the current version 
which needs to be replaced.
1. Click the green icon to substitute 

the old document with the new 
one.

2. A document selection box 
displays.  Select the newly edited 
document from the list and click 
open.

3. The new document title displays 
as the uploaded document.

4. Click Save.  The document title 
now displays as a hyperlink.

Presenter
Presentation Notes
In the field labeled Upload Document is the current version which needs to be replaced.
Click the green icon to substitute the old document with the new one.
A document selection box displays.  Select the newly edited document from the list and click open.
The new document title displays as the uploaded document.
Click Save.  The document title now displays as a hyperlink.
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Mapping Word Bookmarks to CLM Fields

Presenter
Presentation Notes
Scroll down to the Variable section of the CLM Document screen.  The first column, Document Tag, displays all the FLD_bookmarks from the Word Template document.  Item number 8 is the bookmark we added earlier.  Notice the Field  column is blank for item 8.  The third column is also blank.  Options will be determined by the choice selected in the  Field column.  The 4th column will auto populate with information from the other columns. 
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Mapping Word Bookmarks to CLM Fields – cont’d 1

Presenter
Presentation Notes
  Sticking with Item 8, let’s click Select Option in the Field column.    
There are several options.  The document we are working in is part of a solicitation, so we could select that.  However, the option Form Type This means to show options for the type of form that you are amending.  That’s handy!  Let’s choose that!
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Mapping Word Bookmarks to CLM Fields – cont’d 2

In the scenario, bookmarks [fld_SolicitationTitle] 
and [fld_SolicitationTitleTwo] were place holders 
for the same CLM data: Bid Package Title

Presenter
Presentation Notes
Click the Select Option down arrow to see what the options are now that the Field column has been filled in.  Remember in our scenario, we created a new bookmark [fld_SolicitationTitleTwo] as a second injection point for the Bid Package Title.   So here, we would select Bid Package Title from the list.
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Mapping Word Bookmarks to CLM Fields – last

BEST PRACTICE
All  Document Tags 
(Word Bookmarks) 
are linked to CLM 
fields. 

The first four 
columns are 
complete for each 
item. 

Presenter
Presentation Notes
As a best practice all document tags (or Word Bookmarks) are linked to CLM fields.  The first four columns are complete for each item.  

Remember to click the SAVE button at the bottom of the CLM Screen!
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Deploy the Template

Click the DEPLOY button
Document status changes to 
Deployed.
All newly created Bid 
Packages will employ this 
new RFR Template.
Whenever additional 
customizations are needed, 
come back to the document 
screen, click AMEND, and 
start again

Each 
Agency gets 

just one 
customized 

RFR 
template

Presenter
Presentation Notes
Click the DEPLOY button
The document status in the gray ribbon at the top of the page changes to Deployed.
All newly created Bid Packages will employ this new RFR Template.
Whenever additional customizations are needed, come back to the document, screen, click AMEND, and start again.

Remember, changes you make to your department’s RFR template should not be so specific that they only apply to some of the RFRs you write.  The changes should be specific enough to represent your agency but  general enough to be usable agency-wide.  Specific editing occurs when a procurement is underway.  Then, the Working Document is edited to create an RFR that describes the qualities of that procurement.




@Mass_OSD mass.gov/osd29

The Working Document 
employs the customized 
template (highlighted).
Data entered into Bid 
Package Details and other Bid 
Package Sections injects into 
the RFR template upon 
download.
The downloaded document 
should be further refined to 
reflect the needs of the 
specific procurement.

New Bid Packages

Presenter
Presentation Notes
This screen shot shows a new Bid Package in Draft status.  (See that gray ribbon again).  Procurement staff who create bid packages enter data into fields in sections like Bid Package Details, Bid Package Dates, etc.  The data entered injects into the RFR template when it is downloaded from this screen.  The downloaded document should be further refined to reflect the needs, conditions, and attributes of the specific procurement.
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Creating Clauses    Workflow
Basic Workflow for Customizing the RFR Template

Contact the Help Desk for 
initial Template 

deployment for your 
Department

Organizational 
Administrator assigns 

Document Manager (DM) 
permission to COMMBUYS 

CLM user

DM uses Advanced Search 
to locate the deployed 

Document.  Naming 
Convention:  Agency ID_ 

RFR

DM clicks Document link 
to access document 

details, then clicks AMEND 
at the bottom of the page.

DM clicks the hyperlink for 
the document in the 

Upload Document field.  
Clicking the link 

downloads the document. 

DM locates the 
downloaded file and 

opens it.  
(Microsoft Word)

DM makes changes that 
apply to all procurements 

the department may 
undertake. Saves 

frequently.

DM returns to the 
Document (Amending) 

page in CLM and replaces 
the old template with the 

new one.

DM maps all Document 
Tags (Word bookmarks) to 

CLM Fields, clicks SAVE, 
and then clicks DEPLOY.

Presenter
Presentation Notes
Here is a bird's eye view of the workflow we covered today.  (1. Contact the Help Desk for Initial Template deployment for your Department. 2. Organizational Administrator assigns Document Manager (DM) permission to COMMBUYS CLM user 3. DM uses Advanced Search to locate the deployed Document.  Naming Convention:  Agency ID + RFR.  4. DM clicks Document Link to access document details, then clicks AMEND at the bottom of the page. 5. DM clicks the hyperlink for the document in the Upload Document field.  Clicking the link downloads the document.  6. DM locates the downloaded file and opens it.  (Microsoft Word) 7. DM makes changes that apply to all procurements the department may undertake. Saves frequently.  8. DM returns to the Document (Amending) page in CLM and replaces the old template with the new one. DM maps all Document Tags (Word bookmarks) to CLM Fields, clicks SAVE, and then clicks DEPLOY.)
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Resources and Contact Information

Operational Services Division
• Phone: 617-720-3300
• Website: www.mass.gov/osd

OSD Helpdesk
• Phone: 617-720-3197
• Toll-free: 888-627-8283
• Email: OSDHelpDesk@mass.gov
• Website: www.commbuys.comResources

• Best Value Procurement Handbook
• COMMBUYS CLM Resource page
• How to Use Templates in COMMBUYS 

CLM (Video Demo)

Presenter
Presentation Notes
We hope you found this resource useful!  

If you have questions specific to your COMMBUYS account or want to get the ball rolling on customizing the RFR Template,  or are having technical issues, contact the COMMBUYS Helpdesk.

And don’t forget, the OSD homepage offers tools and resources that you can access any time. 

A key resource for all Executive Branch procurement staff is the Best Value Procurement Handbook.  Likewise, we have a CLM Resource page, with job aids, guides, videos and more, including a document version of the presentation you’ve just watched.

If you would like to see the steps covered in this training in action, we have a video demo:  How to Use Templates in COMMBUYS CLM


http://www.mass.gov/osd
mailto:OSDHelpDesk@mass.gov?Subject=COMMBUYS%20Question
http://www.commbuys.com/
https://www.mass.gov/doc/conducting-best-value-procurements-handbook/download?_ga=2.106973890.1705426677.1693243125-116505193.1664536979&_gl=1*q3llfs*_ga*MTE2NTA1MTkzLjE2NjQ1MzY5Nzk.*_ga_MCLPEGW7WM*MTY5MzI0MzEyNS4yMi4xLjE2OTMyNDM0OTIuMC4wLjA.
https://www.mass.gov/info-details/commbuys-clm:%7E:text=COMMBUYS%20Contract%20Lifecycle%20Management%20(CLM,needed%20during%20the%20procurement%20process.
https://app.screencast.com/wkOeLsFSLQrl3
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